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Abstract 

 

Teaching economics in undergraduate classes, particularly at the introductory level, while keeping 

the students engaged and interested in the subject matter is a challenging task. “Chalk and talk” is 

still the dominant teaching method in undergraduate economics. However, in such traditional 

lecture settings, students often lose interest in the subject matter particularly when the emphasis is 

on graphical exposition. Active learning strategies where students are engaged in their own 

learning are regarded as more effective in generating and retaining student interest. In this paper, 

I demonstrate how to develop and use an active learning model using the visual interface of Excel 

that students themselves can control. The model in this paper shows how to teach a competitive 

firm’s shutdown decision. The technique of developing such a spreadsheet-based model is 

discussed in detail. Using this methodology, active learning models can be used to teach other 

topics in both microeconomics and macroeconomics, such as tax incidence, deadweight loss or 

effectiveness of macroeconomic policies among others. Since both professors and students are 

familiar with Excel, these active learning models create a familiar teaching-learning environment. 
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Introduction 

The benefits of active learning that “involves students in doing things and thinking about 

the things that they are doing”2 cannot be overstated. In higher education, the importance of active 

learning has long been recognized.  Chickering and Gamson (1987) included “active learning 

techniques” as an integral part of their widely cited “Seven principles for good practice in 

undergraduate education.” Cross (1987) went a step further and argued that “When students are 

actively involved in the learning task, they learn more than when they are passive recipients of 

instruction.” 

However, in the fourth national survey of teaching and assessment methods in 

undergraduate economics, Watts and Schaur (2011) reported, “there is still relatively little use of 

these practices in undergraduate economics courses. Classroom experiments are now used by a 

small share of instructors in introductory courses, but overall, games, simulations, and experiments 

are almost never used…” Undergraduate instruction in economics has remained largely passive. 

Watts and Schaur further found, “The median amount of time devoted to the use of the chalkboard 

for writing text and graphs during class is also 83 percent in all types of classes, except for upper-

level field courses…..” 

 
1 Professor and Alperin Teaching Fellow, Department of Economics and Finance, Kania School of Management, 

University of Scranton, Brennan Hall, Scranton, PA 18510. The author’s research was partially supported by the 

Henry George Research Fund, Department of Economics and Finance, University of Scranton. 
 

2 Bonwell and Eison (1991) 
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The reasons for such reluctance to use active learning strategies can be traced back to what 

Bonwell and Eison (1991) identified nearly thirty years back as “barriers to the use of active 

learning.” Faculty members often refrain from using active learning strategies, they argued, 

because they feel that incorporation of active learning strategies may reduce coverage of content 

and because it is too time-consuming to develop appropriate active learning strategies. Bonwell 

and Eison argued that perhaps the biggest obstacle to the use of active learning is the perception 

of two types of risks associated with such learning strategies. The first type of risk is that students 

may not participate in the “activities” and consequently, instead of taking charge of their own 

learning, they will be more disengaged. The second type of risk that the faculty often fear is that 

they may not be able to integrate active learning strategies with their existing teaching strategy, 

and as a result, students will not learn as much.  

In a passive learning environment, where students are not actively engaged but observe the 

graphs or tables on the board or on PowerPoint slides, they quickly lose interest and often fail to 

understand what the graphs and tables are meant to explain. This is particularly important in 

introductory classes when most students try to learn the logic of economics for the first time.  

There can be many methods of classroom teaching that ensure active involvement on the 

part of the students. In my class, I use the visual interface of spreadsheet modelling to create active 

learning models. In this paper, I discuss how to develop and use one such Excel-based active 

learning model. The model shows how to discuss the shutdown decision for a competitive firm 

and determine the shutdown price as the minimum of the average variable cost for a firm. I am 

focusing on a very simple yet important concept to build a suitable active learning model so that 

we can concentrate on the mechanics of building the model and using it to enhance student 

learning. This paper demonstrates how I use an active learning framework by using spreadsheet-

based interactive graphs that students can control with the help of scrollbars embedded in the 

graphs. This enables them to observe the direct effect of their actions through their choice of 

changes in values of a parameter and its effect on the diagram. Thus, this tool provides them with 

a hands-on experiment where they are in control of the situation, a clear example of learning by 

doing. As it will be clear from the model, it is not restricted only to this specific topic. The 

procedure can be used to create models for various topics in microeconomics and 

macroeconomics. 

There are two other reasons to use Excel to create an active learning model. Most 

instructors of introductory economics have witnessed a sharp decline in mathematical skills of 

high school students. Introductory economics texts reflect this reality. They rarely use any 

algebraic derivations. Most intermediate microeconomics texts also do not use calculus in the main 

body of the text. However, for more than twenty years there has been growing emphasis on 

computer education in both high school and undergraduate curriculum. While the active learning 

model described in this paper does not require any complicated Excel manipulations for students, 

their familiarity with Excel provides a degree of comfort in carrying out the active learning 

activities. Since the graphs and calculations of the model are based on an Excel spreadsheet, they 

do not appear to be result of some calculations based on some unfamiliar computer programming, 

and they can focus on the economic content of the subject matter.  Finally, since faculty are usually 

very familiar with Excel, the navigation of the spreadsheet and the minimal programming that is 

needed to make the spreadsheets interactive are not likely to pose any great difficulty for the faculty 

to develop these models and use them in their courses.  

The plan of the paper is as follows. In section 2, I present an active learning model that is 

used to teach a competitive firm’s shutdown decision. I explain all the steps that are needed to 
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develop such a model and discuss how the model can be used in the classroom. Section 3 contains 

the concluding remarks.  

 

A Spreadsheet Based Interactive Model: the Shutdown Decision 

The shutdown decision for a competitive firm is taught after students are introduced to the 

two fundamental decision rules that explain that in order to maximize profit a competitive firm 

should produce the level of output where price equals marginal cost (DR1), and the marginal cost 

curve is upward sloping (DR2). Principles of microeconomics texts such as Krugman and Wells 

(2018) or Mankiw (2018) discuss these rules graphically. Intermediate microeconomics texts such 

as Besanko and Braeutigam (2014) or Goolsbee, Levitt and Syversion (2016) supplement the 

graphical analysis, often with some algebraic examples. 

To develop an interactive spreadsheet-based model of the shutdown decision I start with 

the following total cost function: 

 3 216 100 120TC Q Q Q= − + +                                                                                          (1) 

where Q  is the level of output produced by the firm. 

The average total cost (ATC), the average variable cost (AVC) and the marginal cost (MC) are 

given by, 

 2 120
16 100ATC Q Q

Q
= − + +                                                                                             (2) 

 2 16 100AVC Q Q= − +                                                                                                       (3) 

 23 32 100MC Q Q= − +                                                                                                       (4) 

It can be easily verified that the shutdown price or the minimum of the average variable cost is 

$36. 

As the first step to develop an interactive spreadsheet-based graphical model, I plot the 

graphs of the ATC, AVC and MC curves on a worksheet using Excel’s chart option (see figure 

1).3 To graphically determine the profit-maximizing output for the price-taking firm, I need the 

horizontal demand curve given by a price level. However, my goal is to make the graph interactive, 

so that the price line can be moved to different levels thereby creating different profit-maximizing 

outputs. To accomplish this, I insert in cells J4:L4 of the worksheet a “scrollbar” from Excel’s 

toolbar (accessible from Excel’s Developer tab). The details of the steps to insert a scrollbar are 

provided in the appendix. The position of the slider of the scrollbar is reflected in the value in cell 

I4, which I call the Adjust value. (See figure 1). 

The purpose is to move the demand curve by moving the slider of the scrollbar. In order to 

accomplish this, I need to link the price level, P, to the movement of the slider (i.e., the value in 

cell I4). In this model I vary the value of P between the range of 20 (Min) and 100 (Max), which 

are entered in cells F4 and G4. Next, I simulate the value of P using the equation: P = Min + (Max 

–Min)*0.003125*Adjust and enter the formula for P in cell B6 as =F4+(G4-F4)*0.003125*I4. 

Now, as the slider of the scrollbar moves to the right (left), the adjust value in cell I4 increases 

(decreases) and the market price level in cell B6 increases (decreases).The coefficient 0.003125 

used in the simulation equation simply controls the rate of adjustment of the price level. To insert 

the graph of the changeable demand curve on the worksheet, I plot the following points: (0, B6), 

(18, B6). Now as the slider of the scrollbar is moved to the right (left) the demand curve (or the 

price line) moves up or down along with the value of the price level shown in the cell B6. 

 
3 For convenience of drawing the graphs, I use the range of Q from 2.5 to 18. 
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To use this graphical model to demonstrate the firm’s shutdown decision, I need to 

incorporate in the worksheet the calculations for profit-maximizing output and the resulting profit 

level. Assuming that 0Q  , the optimizing rule, P = MC, yields the following solution for the 

output level4: 

 

232 32 12(100 )

6

P
Q

+ − −
=                                                                                          (5) 

The formula for the output is entered in cell B8 as = ((32)+SQRT(32^2-12*(100-$B$6)))/6.  

Next, using the total cost equation from (1), I enter the formula for profit in cell B10 as 

=$B$6*$B$8-(($B$8)^3-16*($B$8)^2+100*$B$8+120). Also, for future reference I enter the 

value of total fixed cost (TFC), 120, in cell B12. 

The structure of the interactive graphical model is now complete. Students can move the 

slider of the scrollbar and observe on the graph how the demand curve moves up and down. Along 

with the price level, the profit maximizing output level is also shown on the graph. The price level, 

output level and the resulting profit level are shown in cells B6, B8 and B10 on the worksheet. 

In order to demonstrate the shutdown decision, I first emphasize that even if a competitive 

firm follows the rule of P =MC and picks the output where the marginal cost is rising, it may not 

earn a positive profit. If a firm earns a negative profit (i.e., incurs a loss), its goal is to minimize 

its loss. However, instead of producing some output, in the short run a firm always has the option 

of shutting down and incurs a loss equal to the total fixed cost.  

For the purpose of this demonstration, at first students are asked to pick any price above 

$55.5 Students can choose any appropriate price level by moving the slider of the scrollbar. Figure 

1 shows the price level of $80 (when the adjust value in cell I4 that shows the position of the slider 

is 240) with the corresponding output level of 10 units. The profit level in cell B10 is shown as 

$280. Students can easily observe that the firm follows the two decision rules for profit 

maximization and earns a positive profit.  

  

 
4 It can be readily verified that given the chosen range of the price level, the solution for output that is based on the 

positive square root of the discriminant, satisfies the second order condition for profit maximization, which requires 

that at the optimal output level the slope of the MC curve must be positive. 
5 The goal is to ensure that at the beginning the price level is such that the firm is seen to make positive profit. Since 

the minimum of ATC is $50.28, any price higher than that is sufficient. Price above $55 is just a convenient choice. 
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Figure 1 

Firm earns a positive profit: P =$80 

 
 

Next students are instructed to lower the price level by moving the slider to the left and 

stop when demand curve is somewhere in between the ATC and the AVC curves. Figure 2 shows 

the price level at $45 (when the adjust value in cell I4 is 100). At this price level, the level of output 

is determined to be 8.51 and the profit level is calculated as -$45.62. In other words, the firm now 

incurs a loss of $45.62. The firm’s other alternative of shutting down and produce no output at all, 

yields a loss of $120—the amount of the fixed cost. In order to maximize profit or equivalently 

minimize its loss, the firm should continue to produce the output of 8.21 and incur the loss of 

$45.62.  

Figure 2 

Firm incurs a loss but continues to produce: P=$45 

 
Next, the students are instructed to lower the market price further and stop when the 

demand curve falls below the AVC curve. Students select their price by moving the slider of the 

scrollbar further to the left. Figure 3 shows the price level at $23 (when the adjust value in cell I4 

is 12). The output level that is determined by following the two decision rules is 7.00 units when 

the profit level is calculated in cell B10 as -$218.00. However, since the firm incurs the loss of 

$120 when the firm shuts down, to minimize loss the firm now decides to shut down and produce 

zero output instead of producing 7.00 units of output and limits the loss to $120. 
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Figure 3 

Firm shuts down: P =$23 

 
 

At this point, I introduce the concept of the “shutdown price” as the (highest) price below 

which the firm shuts down and incurs the loss equaling the total fixed cost. At the shutdown price, 

the firm is indifferent between producing and shutting down and we assume that the firm continues 

to produce. Students now search for the shutdown price by moving the slider of the scrollbar to 

the right, raising the price level and observe the output level (determined by DR1 and DR2) and 

the consequent profit level in cell B10. They continue to raise the price level as long as the amount 

of loss (negative profit) exceeds $120, the fixed cost. They stop when the amount of negative profit 

in cell B10 reaches the level -$120. As Figure 4 shows, this occurs when the price level reaches 

$36 (when the adjust value in cell I4 is 64), which is the minimum of the average variable cost 

(AVCmin), where average variable cost equals marginal cost. The price line or the demand curve 

is tangent to the AVC curve at that price level. Thus, given this cost structure the shutdown price 

is determined to be $36.  

 

Figure 4 

Shutdown price: P = AVCmin =$36 
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The two decision rules (DR1) and (DR2) stated above now can be supplemented by a third 

decision rule, (DR3) which states that the firm produces a positive amount of output following 

DR1 and DR2 , as long as PAVCmin, the shutdown price. The firm shuts down and produces 

0Q = , if P<AVCmin. 

Since numerous data points for price and output can be generated by moving the slider, 

students can also use those data points to draw the short-run supply curve on the worksheet. In this 

entire activity, students can select any price level that they choose and observe the resulting output 

and profit levels. However, they ultimately determine the shutdown price is the minimum of the 

average variable cost.  

The advantage of using this simple model is that students engage in changing the price 

level, observe its impact on output and profit levels instead of listening to a lecture, and observe 

the graphs drawn on the board or the PowerPoint slides. This simple active learning model provides 

them the opportunity to be active participants in their learning rather than being passive observers. 

Since the students themselves engage in manipulating the graphs and search for the shutdown 

price, the activity opens up the opportunity for more discussions in the classroom. I have 

experienced that students become more engaged in their learning process, they become more 

interested in the topic, and they retain the material better than when it is presented in traditional 

lectures. 

 

Conclusion 

In this paper, I have demonstrated how to develop and use a spreadsheet-based active 

learning model to teach the shutdown decision of a competitive firm. The strength of this approach 

lies in its simplicity. Although the navigation of the model does not require any deeper knowledge 

of Excel, the Excel worksheets provide a familiar set up for the students. In my class, I always 

have students actively participating in manipulating the graph and generating their own data to 

analyze. In addition, since students are engaged in working with the model, we can focus on the 

economic reasoning and can cover the topic efficiently.  

Since faculty are usually very familiar with Excel, as the paper has illustrated, it is not too 

time-consuming to develop and use the model in class. There is of course no single approach to 

teach undergraduate economics. However, the model can be easily integrated with any method of 

teaching and can be used in classes of different levels of rigor. This particular model can be used 

in a principles class as the main vehicle for presenting the topic. In an intermediate 

microeconomics class, this model can be used to review the topic and it can be supplemented by 

algebraic derivation or calculus as warranted. For example, in an intermediate microeconomics 

class, the use of this model can be supplemented by derivation of optimal output and the profit 

levels. 

It should be noted that the spreadsheet-based model can be used to discuss many topics 

besides the shutdown decision this paper illustrates. Following the steps shown in the paper, I have 

developed several other models to discuss both microeconomic and macroeconomic topics, such 

as tax incidence, deadweight loss of an excise tax, entry-exit decisions in a competitive market, 

the long run supply, IS-LM model, macro policy effectiveness, and aggregate demand – aggregate 

supply model, among others. 
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Appendix: Using Scrollbar in Excel Worksheet 

Click on the Developer tab on the ribbon (if the Developer tab does not appear on the 

ribbon, then go to, File>Options>Customize Ribbon. Under the main tabs, click Developer). Then 

click on Design Mode to turn it on. 

The next step is to insert a Scrollbar on the Excel worksheet. Click on Insert (next to Design 

Mode) to access the list of Form Controls (and Active X Controls). Click on Scrollbar from the 

list and insert it in cells J4-L4. 

We will now link the scrollbar to the values in the worksheet to create animated graphs that 

can be controlled by the movement of the scrollbar. To accomplish this first right click on the 

slider of the scrollbar to open a window. Click on Format Control at the bottom of the window. A 

Format Control dialog box opens up. Under the control tab, enter the following values: 0 for 

Minimum Value, 320 for Maximum Value and 1 for incremental change. Finally enter the address 

cell I4 ($I$4) for cell link. Click OK. 

Now the slider of the scrollbar can be adjusted from a value of 0 to 320 with an increment 

of 1 and its positional value is shown in the cell I4 on the worksheet under the heading Adjust. 

 


